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[bookmark: _Toc32927724]Using This Document


Once you understand the type of information you need to provide in the Equitable Distribution (eQuit or ED) Spreadsheet, use this User’s Guide as you would a cookbook to pick out what you need (or explore basic functionality and useful topics).  It’s not necessary to need to read every word when you’re just beginning.  Just scan the Table of Contents, the FAQ and the Appendices.  Everything you need to know about the spreadsheet (and more) is here.  Then dive as deep as you need.    

When viewing this User’s Guide as a Word document:

· Each entry in the Table of Contents is linked to the respective section in the document.
· Return to the top of the document, by pressing the keys:

Mac	⌘ + fn + ◀︎

PC		ctrl + Home


Enjoy!



[bookmark: _Toc32927725]What’s New in v36


The following is a small list of enhancements that have been added to Version 36 of the Equitable Distribution (eQuit or ED) Spreadsheet.  Other changes are indicated in the document.

· A new Case Style information sheet.
· Case number
· Alternate label options for Petitioner and Respondent.
· Ability to import existing eQuit spreadsheets and eQuit formatted, .csv files.
· Compute equitable distributions automatically (based on valuation and possession).
· Combine data from multiple rows into a single row (forced merge).
· Review spreadsheets for common types of errors.
· Annotate valuations with string values (allowing you to mark items for follow-up).
· New tools to:
· Sort entries by item and/or possession.
· Move items to a different category.
· Erase rows.
· Delete unused rows.
· Delete rows without having to delete the links beforehand.
· Row number.
· Printing enhancements
· Page/time stamps on printed pages.
· Improved layouts.
· Performance improvements 
· Spreadsheet loading.
· Large spreadsheets.
· Progress bars for monitoring progress.













[bookmark: _Toc32927726]Introduction


What


· The eQuit Equitable Distribution Spreadsheet is a collection of Microsoft Excel spreadsheets[footnoteRef:1],[footnoteRef:2]. [1:  You must have Microsoft Excel installed on your Mac or PC to use this spreadsheet.  ]  [2:  This figure is a representation of the spreadsheet look and feel.] 


           

















· Assets and liabilities are organized in a concise, unified format with computation of an equalizing payment from that information[footnoteRef:3]. [3:  Actual spreadsheets may be viewed here:  Assets, Liabilities, Notes, Miscellaneous and Summary.] 

· The entire user experience (data manipulation, computations, printing, etc.) utilizes standard Microsoft Excel spreadsheet operations.





Why

· Organizes assets and liabilities in a format that is concise and easy to read.
· Reduces confusion because the Parties use common terms and discuss valuations of marital assets and liabilities before coming into court.
· Provides Parties an opportunity to review necessary trial information and work out stipulations.
· Allows the Court to compare both Parties’ assessment of marital assets and liabilities.
· Summarizes totals and subtotals by category.
· Computes an equalizing payment, for both the Parties’ proposed distribution and the distribution determined by the Court.


How

· Download the spreadsheet and enable the built-in macros. (Note: make sure you remain macro-enabled)
· Convert the spreadsheet to a Personal Excel Macro -Enabled Template.
· Launch Excel and open the Equitable Distribution Template and add your case information to the spreadsheet.
· Save your spreadsheet to a standard, shareable, Excel file.


Where

· Find a link to the spreadsheet here:
https://ninthcircuit.org/about/judges/circuit/diana-m-tennis 

· For help or suggestions about the spreadsheet, please send email to:
ctjudt2@ocnjcc.org, and include a screen shot of the problem .  Please do not reference specific cases or information about any specific case. If you are sending the actual spreadsheet for technical assistance, notice all parties if it is a division 30 case.  
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[bookmark: _Toc32927728]The Equitable Distribution Spreadsheet

The Getting Started page is the home page for the Equitable Distribution Spreadsheet is the access point for all spreadsheets and on-line information.

[image: ]



The Getting Started page is organized according to task:

	Icon
	Link to …

	
	

	Before you start
	General Directions 

	Fill in the spreadsheet
	Case Style page in the eQuit spreadsheet

	Download the User’s Guide
	eQuit User’s Guide (this document)

	Printable (blank) forms
	Form equivalents of the eQuit spreadsheet

	Contact us
	Home page for contact information and eQuit downloads

	9th
	Home page for the Ninth Judicial Circuit Court of Florida




To perform a task, click on the blue icons along the right-hand margin. 



The Case Style page is the introductory page for starting a new Equitable Distribution Spreadsheet.

[image: ]
[bookmark: _Spreadsheets]

The Case Style page is a form designed for you to enter necessary information about your case:

	Field
	Description

	
	

	Case Style
	Each party’s name in the form:  Petitioner v. Respondent

	Case Number  
	Court case number

	Petitioner’s Label  
	Preferred label for the petitioning party

	Petitioner’s Label  
	Preferred label for the responding party

	Date of marriage  
	Date of marriage

	Date of filing
	Date of filing

	Role  
	The role of the person for which the information is being entered


Details about using the Case Style page can be found in the Case Style Page section of the Lagniappe. 

Once you have completed the case style, use the tabs along the bottom to move to your desired page, or use the [image: ]  arrow icon (in the left-hand margin) to move to the first spreadsheet—Assets.  

[bookmark: _Toc32927729] Pre-Mediation

Consider using having clients fill out printable forms when putting together the initial Financial Affidavits, so that you can begin to create your Equitable Distribution Spreadsheet early. The Spreadsheet may be printed with one Parties’ values and attached to the Financial Affidavit. The Spreadsheet may be shared with opposing Party and mediator for use at mediation, or both Parties may complete a joint spreadsheet for use at mediation. 

Each Party may now complete their own spreadsheet and then “merge” them into a joint spreadsheet later in the case. This can be  done by following the instructions outlined here. 

[bookmark: _Toc32927730]Pre-Trial

If the spreadsheet is not created while the attorneys are together:

· Each Party should complete their portion of the  Equitable Distribution Spreadsheet and coordinate the “labels” used in the Case Style page and “possessors” . Remember to save with identifying name once completed. Either the Petitioner, or Respondent if by agreement, shall take both eQuit spreadsheets and “merge” them following the instructions found here. 
· Upon completion, the Joint ED Spreadsheet should be emailed back to the opposing counsel/party so they can review  and add any items or information.  Once both sides have seen all new additions, the Joint ED Spreadsheet should be attached to the Joint Pretrial Memorandum, or filed independently, and provided via email to the trial Judge. .


Each Party should:

· Enter valuations for assets and liabilities and proposed dates of valuation. You may not change the data entered by another Party. 
· Ensure your proposed distribution adds up to the total amount you indicated in your valuation column.
· If there is agreement as to valuation and distribution, enter the same data OR place agreed upon data in the Court Valuation column.
The joint spreadsheet should be printed and filed with the Joint Pre-Trial Memorandums and sent electronically (email) to the Judge prior to Pre-Trial or Case Management Conference.
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The Equitable Distribution Spreadsheet organizes assets, liabilities and summary information into separate spreadsheets (“pages”) within a workbook.    

[image: ]

All the spreadsheets use standardized layouts and data manipulation operations.

1. Categories are listed in the blue banner along the left-hand margin of every page. 
2. Valuations, proposed distributions and court decisions are organized into columns across the top.
3. Values such as item descriptions, amounts and possession are entered in the cells within the table.
4. The eQuit toolbar, located at the top of every page, contains page-wise, spreadsheet tools.
5. The Category toolbar, located on the subtotal row of every category, contains category-specific (i.e. row-specific) tools.    
6. Tabs for switching between pages.



For example, in the figure above, the Marital Asset contains the following categories (visible):

· Real Property
· Accounts
· Retirement
· Pre-Tax Retirement

If you are having trouble viewing the entire spreadsheet on your display, use the zoom slider in the bottom right-hand corner of the spreadsheet.  Or, click on the slider value (e.g. 90%) and select a number to enter a specific zoom value.

Information common to all assets and liability pages are outlined below.

Possession 
Refers to who is in possession or is named on the asset/debt.
If there is further information necessary it may be placed in the space below that item, or the Notes page.  Enter a value by selecting the field and selecting a value on the drop-down list.

Signor 
Refers to whose name the debt is in.

Item 
Should include description of sufficient detail and last four digits of any accounts.

Institution + last 4 digits 
Refers to the bank or financial institution holding the account and the account’s last 4 digits. Hint:  Typically, a “#” may be used in front of those numbers. If merging two Spreadsheets, common use or non-use of that symbol may assist with ease of merge. 

Date & Valuation 
Most typically the date of filing, this is the date suggested for valuation, and the valuation as of that date.

· Enter a date by selecting the field and entering a valid date.  
· Enter a valuation by selecting the field and entering a positive number for an asset and a negative number for a liability.
· If you are using a different valuation date than Date of Separation or Date of Filing, add a note in the Notes page.

It is possible to view an equalizing payment for each subtotal (category) on the Assets and Liabilities pages.  Details about this can be found in the Equalize subtotals section of the Lagniappe.

Amounts entered in the spreadsheet are expressed as follows:

· If you prefer, amounts may be entered to the penny.
· Calculations are made using the amounts entered into the spreadsheet.
· For readability, amounts are rounded and displayed to the nearest dollar.

Details about manipulating the spreadsheet (adding/deleting rows, printing, etc.) can be found in the Lagniappe section of this document.

[bookmark: _Toc32927733]The eQuit Toolbar

The eQuit toolbar, for page-specific operations, is located at the top of every spreadsheet.

	Icon
	Description
	Link

	
	
	

	 [image: ]
	Unlock spreadsheets
	Unlock spreadsheets

	
	
	

	 [image: ]
	Set role
	Set role

	
	
	

	 [image: ]
	Print spreadsheets
	Print spreadsheets

	
	
	

	 [image: ]
	Move selected rows to a new category
	Move / reorder rows

	
	
	

	 	
	Combine multiple rows into one
	Combine rows

	
	
	

	 [image: ]
	Review spreadsheet for errors
	Review spreadsheets

	
	
	

	  #
	Add row numbers
	Row numbers

	
	
	

	  [image: ]
	Resize item column width
	Resize item column

	
	
	

	[image: ]
	Display equalizing payment table
	Equalizing payment

	
	
	





[bookmark: _Toc32927734]The Category Toolbar

The Category (i.e. row-specific) toolbar, for category operations, is located on every subtotal row.  


	Icon
	Description
	Link

	
	
	

	[image: ]
	Hyperlink Notes 
	Add notes 

	
	
	

	[image: ]
	Move row up
	Move / reorder rows

	
	
	

	[image: ]
	Move row down
	Move / reorder rows

	
	
	

	[image: ]
	Add rows
	Add rows

	
	
	

	[image: ]
	Delete rows
	Delete rows

	
	
	

	[image: ]
	Display Equalize subtotals
	Equalize subtotals


[bookmark: _Add_rows]
More information about these tools can be found by selecting the links in the table above.

[bookmark: _Case_Style_Spreadsheet][bookmark: _Toc32927735]Case Style Page

The Case Style page is the starting point for generating a new Equitable Distribution Spreadsheet.  The Case Style page is organized as follows:

Case Style 	 
Each party’s name in the form:  Petitioner v. Respondent.  Required.

Case Number  
Court case number. Required.

Petitioner’s Label   
Renames the default Petitioner label (“Petitioner”) to something that is more meaningful/recognizable.  This label will be used in all table headers and pull-down menus.



Use the drop-down list associated with the field to select one of the following choices:

· Husband (or variant)
· Wife (or variant)
· Petitioner

Although not required, it is recommended that you specify the label when you start the spreadsheet and not change it once you’ve started your spreadsheet.  Doing so will ensure the drop-down list of possessors is always synchronized with your choice of labels.  Details about how to synchronize the possessor values can be found in the Rename Possessors section of the Lagniappe. 

Respondent’s Label  
Renames the default Respondent’s label (“Respondent”) to something that is more meaningful/recognizable.  This label will be used in all table headers and pull-down menus.

Use the drop-down list associated with the field to select one of the following choices:

· Husband (or variant)
· Wife (or variant)
· Petitioner

Although not required, it is recommended that you specify the label when you start the spreadsheet and not change it once you’ve started your spreadsheet.  Doing so will ensure the drop-down list of possessors is synchronized with your choice of labels.  
If you must rename the Petitioner after entering data into the spreadsheet, you can synchronize the possessor values in the spreadsheets with the labels.  Details about how to do this can be found in the Rename Possessors section of the Lagniappe. 

Date of marriage  
Enter the date in the mm/dd/yyyy format.  Required.

Date of filing   
Enter the date in the mm/dd/yyyy format.  Required.



Role  
The role of the person for which the information is being entered (typically Petitioner, Respondent or Joint).  The role is used to limit the available fields to only those required for the particular party and is optional.

· Petitioner (or label as specified above)
· Respondent (or label as specified above)
· Joint
· Judge

You may change the role at any time during the building process.    Details about the benefits of using roles can be found in the Roles section of the Lagniappe.  

[bookmark: _Toc32927736]Assets Page

Marital assets should be assigned to one of the following resource categories[footnoteRef:4], or described in the Assets.Notes section as set out herein.  Non-Marital assets may be set out in the Notes page, or the Joint Pre-Trial Memorandum. [4:  Assets and liabilities are organized into categories.  This is concept that is used throughout the documentation. ] 


· Real Property
· Accounts
· Retirement
· Pre-Tax Retirement [footnoteRef:5] [5:  If the Parties are in agreement that the Marital portion of a Pre-Tax Retirements will be divided equally by separate division of those assets not to be included in the summary calculation, with/or without tax effect, that may be set out in the Assets.Notes section, or included with detailed agreed division in the Assets section.] 

· Business Interest
· Personal Property [footnoteRef:6] [6:  Parties are on notice the Court will not typically value minor personal property, but divide property between the parties. The Court may also deal with personal property outside of the Spreadsheet, refer the Parties back to mediation, or appoint a special master to help with distribution. ] 

· Vehicles [footnoteRef:7] [7:  This would include boats, motorcycles, campers, trailers, and the like.] 

· Contingent Assets
· Miscellaneous

The valuation for an asset can be a number or a text string.  All numeric values must be positive. Text strings can be used to annotate an item when the valuation or distribution has yet to be determined, for example using TBA or UNK. Marital Valuations should not be left blank. 
This section is only to be used for assets that are being valued.  If a marital asset is being divided equally and as of a date and without a specific amount being known, i.e. some pensions/retirement,  that asset should be itemized in the Assets.Notes section (and in the Joint Pre-Trial Memorandum).  If an approximation can be made as to the marital and non-marital portions of that asset, it should also be included in the Assets.Notes page.  Those numbers will not be included in the Summary page.

Business Interests may be entered on the Assets page, on the Assets.Misc page , or on the Assets.Notes page. Given the unusual issues surrounding this type of asset, it may be more expedient to add details about the Parties’ valuations in the Joint Pre-trial Memorandum and merely reference this in the Assets.Notes section.

Lengthy lists of personal property, and non-marital assets may be included in the Assets.Misc page.  
Items that need to be described further such as tax affected distributions, may be noted in the Assets.Notes page.

For assets that have a non-marital and marital component, only the Party’s proposed marital value should be entered in the distribution columns.  The actual value may be listed in the valuation column and an explanation made of the difference in the Assets.Notes section.[footnoteRef:8]  If the marital portion (enhancement of non-marital property) is being calculated using the formula in Florida Statute 61.075 (pre-marital real estate for example) information related to the calculation may be included in the Joint Pre-trial Statement, in the Assets.Notes section of this Spreadsheet, or both.  Data in the valuation column will not be included in the ED totals, nor appear in the Summary section. [8:  For example, if there is a piece of property with a market value of $100,000, but the Party believes only $50,000 of that is marital, they may put the 50k in the Valuation column, and then link the  valuation to a note in the Assets.Notes section to explain.] 


The Parties may create links to marital asset notes in the Assets.Notes section, so that the Judge will know when looking at the asset that there is pertinent information.  Those instructions are in the Add Notes Using Hyperlinks section of the Lagniappe.

An example of the Assets spreadsheet can be found in the Appendix section.

[bookmark: _Assets.Misc]

[bookmark: _Toc32927737]Assets.Misc Page

Use the Assets page whenever possible.  Only uncategorized and lengthy lists of assets should be added to this page.  

The valuation for an asset can be a number or a text string.  All numeric values must be positive. Text strings can be used to annotate an item when the valuation (distribution) has yet to be determined (decided).

An example of the Assets.Misc spreadsheet can be found in the Appendix section.

[bookmark: _Assets.Notes][bookmark: _Toc32927738]Assets.Notes Page

Additional details about an asset should be added to this page.  Non-marital assets may also be listed here.  This is also where to include information about an asset being divided as of a date and without a specific amount being known.  If an approximation can be made as to the marital and non-marital portions of that asset, it should also be included.  This data will not be included in the Summary page. Notes should be very brief, if a longer explanation is needed, it should be included in the Joint Pre-trial Memorandum/Stipulation.

An example of the Assets.Notes spreadsheet can be found in the Appendix section.

[bookmark: _Toc32927739]Liabilities Page

Liabilities should be assigned to one of the following obligation categories.

· Mortgage
· Credit Cards
· Vehicle Loans
· IRS Debt
· Contingent Liabilities
· Miscellaneous

The valuation for a liability can be a number or a text string.  All numeric values must be negative. Text strings can be used to annotate an item when the valuation (distribution) has yet to be determined (decided).

Non-marital liabilities should be included in the Liabilities.Notes section.

Lengthy lists of liabilities, credit cards for example, may be included in the Liabilities.Misc spreadsheet. 

Items that need to be described further may be noted in the Liabilities.Notes spreadsheet.
The Parties may create links to marital liability notes in the Liabilities.Notes section.   Those instructions are in the Add Notes Using Hyperlinks section of the Lagniappe.

If a Marital Liability is being divided as of a date and without a specific amount being known, that asset should be itemized in the Liabilities.Notes section (and, if a longer explanation is needed, in the Joint Pre-Trial Memorandum).  If an approximation can be made as to the marital and non-marital portions of that debt, it should also be included in the Liabilities.Notes page.  This data will not be included in the Summary page.

An example of the Liabilities spreadsheet can be found in the Appendix.

[bookmark: _Liabilities.Misc][bookmark: _Toc32927740]Liabilities.Misc Page

Use the Liabilities spreadsheet whenever possible.  Only uncategorized and lengthy lists of liabilities should be added to this page.  

The valuation for a liability can be a number or a text string.  All numeric values must be negative. Text strings can be used to annotate an item when the valuation (distribution) has yet to be determined (decided).

[bookmark: _Toc32927741]Liabilities.Notes Page

Additional details about a liability should be added to this page.  Non-marital assets may also be listed here.  This is also where to include information about a liability being divided as of a date and without a specific amount being known.  If an approximation can be made as to the marital and non-marital portions of that asset, it should also be included.  Those numbers will not be included in the Summary page.



[bookmark: _Toc32927742]Summary Page

The Summary page contains the equalizing value (payment/credit) as well as totals for the distributed assets and liabilities for each litigant.  

For readability, amounts are rounded and displayed to the nearest dollar.  Exact values are displayed in the Excel status bar (bottom left corner of the window) when a cell is selected.

Total Assets 				Combined subtotals from Assets and Assets.Misc
Total Liability				Combined subtotals from Liabilities and Liabilities.Misc
Net							Total assets + total liability
Equalizing Payment	Half, the difference between the 
Petitioner’s net and the Respondent’s net.  
A negative equalizing value is a payment.  
A positive equalizing value is a credit.  
The higher net credits the lower net an amount equal to the equalizing payment.
Net Equalized				Petitioner’s net + their equalizing payment/credit.
							Respondent’s net + their equalizing payment/credit.
These values will be equal.

An example of the Summary page can be found in the Appendix section.



[bookmark: _Toc32927743]Settings Page

Use the Settings page to customize the eQuit environment and tools.  Options are arranged in sections according to functionality.

Layout Options

	Options that allow you to manage aspects of the spreadsheet layout and formatting.
	These options are described in context in the Lagniappe section.

Print Options

	Options that allow you to manage aspects of printing.
	These options are described in context in the Lagniappe section.

Tool Options

	Options that allow you to manage some aspects of how the tools are defined and used.
	These options are described in context in the Lagniappe section.

Input/Output Options

	Options that allow you to manage some aspects of importing and exporting.
	These options are described in context in the Lagniappe section.

Review Options

	Options that allow you to manage some aspects of the review guidelines.
	These options are described in context in the Lagniappe section.










[bookmark: _Toc32927744]Lagniappe[footnoteRef:9] [9:  Definition:  ( \ ‘lan-yap: a small gift with purchase )] 
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	Tool
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	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

To add a row to a category, select the add row icon +  on the category toolbar.  

[image: ]

By default, new rows are added to the end of the category.  When the currently selected cell is inside the category, the new row is added after the selected row.









To quickly add multiple rows to your spreadsheet, two approaches can be followed: 

· The Add row increment spin button under the Tool Options heading on the Settings page can be used to set the increment value so that ‘increment' rows are added when the  +  icon is selected.  The default increment is 1.
· Use a selection rectangle to select multiple cells, then select the  +  icon.  The number of rows added will be the number of rows selected.  Rows are added after the selection rectangle.  Note:  the selected rows do not have to be empty (the add tool simply uses the number of selected rows to determine a temporary ‘increment').

[bookmark: _Toc32927746]Add Notes Using Hyperlinks

	Tool
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	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

It is quite easy for the Court to determine that important information is in the notes section and what that information relates to when they can see the bold/underlined data. The hyperlinks allow for quick movement between that data and the related note. This is worth learning!

To hyperlink an item in an Assets (or Liabilities) page to a note in a Notes page, 

· select the cell you wish to reference, then 
· select the footnote icon  [image: ]  on the  category toolbar.  

[image: ]



A dialog prompting you to select a location on the Notes spreadsheet will appear.  

[image: ]

Create the hyperlink by selecting a cell in the table for the new note.  Information from the referred item will be copied into the new note.  The selected row is also where you complete your footnote information. 

[image: ]

A hyperlink between the chosen item (in the Assets or Liabilities pages) and the Notes entry is created for you.  A return hyperlink (between the note and the chosen item) is also generated. 



If during the process of adding a hyperlink, you should discover (mid-operation) that an empty row is not available in the Notes page, select the green highlighted cell to the right of the  category toolbar.  
    

[image: ]

A new row will be added at the end of the list, and the hyperlink will be inserted in that row.

[image: ]

Apply the hyperlink to the field that most identifies with the information in the footnote.  For example:

· For general information about an item, link the footnote to the Description field.
· To include information regarding a valuation, link the footnote to the Valuation field.  Use the Petitioner and Respondent notes categories in the Notes page to identify the source of the information. 
· To include information regarding a proposed distribution, link the footnote to the Distribution field.  Use the Petitioner and Respondent categories in the Notes page to identify the source of the information.

An asset or liability may have multiple links in that row, but each link can only reference a single footnote.  

If an asset or liability item has more than one link (e.g. a description, valuation or distribution needs further explanation), add an unlinked note.  For clarity, you can organize footnotes according to their description or category (using the  [image: ]  and  [image: ]  icons).

To unlink a hyperlink, move the cursor into the hyperlinked cell and select the  [image: ]  icon.  

Try to remember not to use the Delete key to remove the link.  Adding a link to an Excel spreadsheet changes the label’s font, color and underline.  If you use the Delete key to remove the link, the next time you add text in that cell it will be formatted using the color and underlining of the hyperlink style even though the cell is no longer a hyperlink.  

Should you accidently use the Delete key to delete a hyperlinked cell, the easiest way to correct the problem is to empty the contents of the cell and select the  [image: ]  icon.  

An item description must be provided before a footnote can be added. 

[bookmark: _Combine_Rows][bookmark: _Toc32927747]Combine Rows (Forced Merge)

	       Tool
	



	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

The combine tool         takes two or more rows of data within a category and forces a merging of the dates, valuations, and distributions using the primary row’s item description. This is particularly helpful after two eQuit Spreadsheets have been merged and differences in descriptors led to multiple entries for the same item.

To use the combine tool:

· Select a cell in the primary row.  The receiving area for all the combined data is the primary row and it is the first row selected.  When using a selecting rectangle, the primary row is the upper row of the rectangle.
· Select a cell in the secondary row(s).  Information from the secondary rows is copied to any missing cells in the primary row.
· Select the combine tool           located on the eQuit toolbar at the top of the spreadsheet.
· Hyperlinks are maintained when rows are combined.

When combining assets or liabilities, the selected rows must be in the same category.

When combining notes, the note details are appended into a single, bulleted list.  This feature can be used to keep relevant information together and minimize the number of links in the referring item.

[image: ]

Once you have completed the combine operation, the primary row is deselected, and the secondary rows remain selected.  

[image: ]

Verify that the information was combined as expected, then use the   [image: ]  tool to clear/delete the secondary rows.

[image: ]

Remember that during a merged import, items that don’t match exactly will be appended--not merged.  If the item descriptions differ as a result of misspellings, spacing, abbreviations or terminology, you can use the combine tool to force the rows to merge.  

Details about addressing merges after importing can be found in the Merge/Append Imported Spreadsheets section of the Lagniappe. 



[bookmark: _Toc32927748]Consolidate Columns 

	Spreadsheets:    Settings

To hide columns that are not relevant to you, select one or more of the Display columns check boxes under the Layout Options heading on the Settings page.
 
[image: ]

The columns that may be hidden include:

· Petitioner and Respondent valuations
· Petitioner and Respondent proposed distributions
· Court determined distributions

The default is to display all the columns. If you prefer to never see the Court Valuation Column, for example, you can change this in setting prior to saving the eQuit Spreadsheet as a template. You can always change the view in any open Spreadsheet in the Settings page. 

Use this feature to simplify the spreadsheet and to create more space on the screen and printed pages.

[bookmark: _Toc32927749]Consolidate Rows

	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

To consolidate/hide categories, some spreadsheets have group (accordion) controls in the left-hand margin of the spreadsheet window.  For example, you can hide all the Real Property items in the Assets spreadsheet with group controls.  This may be useful when a category is empty, irrelevant, distracting or the spreadsheet is becoming too large to manage.





A row group is delineated with a vertical bar inside the left margin.[footnoteRef:10]  [10:  If you do not see the group controls in your spreadsheet, your version of Excel may require that headings be enabled for this feature to work.   Enable headings by selecting Headings in the View tab of the Excel Tool Ribbon.
] 


[image: ]

The row group bar has a [+] or a [-] controls at one end.

· [-] indicates the last row an expanded group.
· [+] indicates the position of a hidden row group.

Select the [+] or [-] controls to expand or condense a specific row group.

In the upper left corner of each page of the spreadsheet, there are controls labeled [1] or [2] that allow you to condense or expand all the rows at one time.

Hidden rows are not printed.




[bookmark: _Toc32927750]Copy and Paste from the Clipboard  

	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

You may paste data from the clipboard using standard, Excel paste operations as long as the values do not extend beyond the protected columns or category boundaries.

Common sources of copied data are:

· Excel spreadsheets and text files (e.g. from clients who do not have the eQuit Equitable Distribution Spreadsheet).
· Other eQuit Equitable Distribution Spreadsheets (e.g. from opposing counsel during the collaborative process).

You should always use the paste menu popup located in the lower right corner of the pasted area to apply the destination formatting to the pasted region (as shown below).

[image: ]

A predefined keyboard shortcut, ctrl + shift + v, will paste the contents of the clipboard and automatically apply the proper formatting (without having to use the popup menu).

To paste one or more rows of data you will need to unlock the spreadsheet.  For information on about that, see the Unlock Spreadsheets section of the Lagniappe. 

For a discussion of the many gotchas associated with cut and paste, see the section,  "Annoying Things about Excel's Copy, Cut and Paste", at the end of this Lagniappe.

[bookmark: _Toc32927751]Delete Rows

	Tool
	[image: ]



	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

To delete a row in the spreadsheet, 

· Select a cell in the row you wish to delete.
· Select the delete icon  [image: ]  on the category  toolbar.

By default, the currently selected row in that category is deleted.  If there are no rows selected in that category, then the last row in the category will be deleted.  

To delete multiple rows in a category, 

· Select a cell in each row you wish to delete, then 
· Select the  [image: ]  icon located within that category.   
· Use rectangular selection or non-contiguous selection to select multiple rows.

Details about how to delete all the unused rows from every page of the spreadsheet can be found in the next section. 

[image: ]
[bookmark: _Move_/_reorder]


The  [image: ]  icon can be configured using the options buttons under the Tool Options heading on the Settings page.  

· The default behavior for the  [image: ]  icon is to erase the contents of a row.  Once the rows are empty, select the  [image: ]  icon a second time to delete the rows from the spreadsheet.  Row clearing is done without a prompt.
· The alternative option is for the  [image: ]  icon to delete the rows and prompt with a warning if the row(s) are not empty.

A category must always contain at least one row.
Deletions cannot be undone.

[bookmark: _Toc32927752]Delete Unused Rows

	Spreadsheets:    Settings

To delete all the empty rows in the eQuit spreadsheet, select the Delete unused rows push button under the Tool Options heading on the Settings page.
[bookmark: _Delete_rows][bookmark: _Debug]
It is not necessary to remove the empty rows in your spreadsheet windows in order to compress your printed output. There is a similar print option under the Print Options heading on the Settings page that will handle this automatically.

[bookmark: _Toc32927753]Equitable Distributions (Auto-Computed)

	Spreadsheets:    Settings

By default, the equitable distribution computed for you whenever a possessor is specified, and an item’s possession and valuation are entered.  

Distributions are computed as a function of the possession and the valuation:

· For an item possessed by an individual, 100% of the valuation is assigned to that individual’s distribution.
· When the item is possessed jointly, 50% of the valuation is assigned to each Party’s distribution.
· For each Party, the sum of their distributions will always be equal to their valuation.
· The computed amounts are starting points and may be modified by the Parties as long as the total equals the Party’s valuation OR the auto calculate is turned off in Settings (see next section) OR the possessor is left blank.  

In order for the spreadsheet to compute the distributions, you must:

· Enter the possessor first.
· Next, enter the valuation.
· The distribution is a function of the possessor. 
· The sum(distributions) will be equal to the valuation.
· The calculated distributions are modifiable. 

Distributions are recomputed anytime a valuation or distribution is edited.  A cell is considered edited when:

· Its value is changed
· You double-click on the cell
· Selecting or tabbing into a cell is not considered editing.   

Computed distributions may be modified after the automatic distribution calculation.  When modified, the opposing Party’s distribution is offset so that the total distribution is equal to the valuation.

Valuations may be modified after the distribution is computed.  When the valuation is changed, each Party will be assessed/awarded half the change in valuation.  The computed distribution can always be modified if the result is not what you intended.

The significance of possession:

Possession drives all computations of the distribution.  The converse is also true—distribution calculations are disabled when the possessor is empty.  

To avoid computed distributions, enter the possession last when there is a justifiable reason for the sum(distributions) to differ from the valuation, or turn off the operation in Settings.

Once the distributions are calculated, changing the possessor no longer affect the distributions.  If this is not what you intended, you will need to correct the updated distribution.

When the parties are in total agreement with respect to valuation and distribution (and possession has been specified), the proposed distributions may be copied to the Court determined distributions.

The Calculate based on possession and valuations option button under the Tool Options heading on the Settings page can be used to set this option if it is not already set.  See the next section for details about turning the compute feature off.


[bookmark: _Toc32927754]
Equitable Distributions (Not Auto-Computed)

	Spreadsheets:    Settings

To turn off automatic Equitable Distribution computations, select the Do not calculate option button under the Tool Options heading on the Settings page.

This may be useful when there is justification for the sum(distributions) to be different from the valuation.

It is not necessary to turn automatic calculations off in order to avoid the distributions computed by the automatic option.  Distributions entered before a possessor is entered are not affected by the automatic computations.  Remember, however, once the possession is set, changing a valuation or a distribution will trigger an automatic recalculation. 

See the previous section for details about turning the compute feature on.

[bookmark: _Equalize_subtotals_1][bookmark: _Toc32927755]Equalizing Amounts for Subtotals
	
	Tool
	[image: ]



	Spreadsheets:    Assets   Assets.Misc   Liabilities   Liabilities.Misc

To view equalizing subtotal information for a category as assets and liabilities are distributed, select the icon   [image: ]   located at the end of the Subtotal header.

[image: ]





	
		
Select the   [image: ]   icon a second time to hide the equalize subtotals information.

Use the   [image: ]   icon on the Total line at the bottom of the Assets and Liabilities spreadsheet to hide/unhide the equalizing subtotal information for all the categories at once.
[bookmark: _Toc32927756]Equalizing Payment

	Tool
	[image: ]



	Spreadsheets:    Assets   Assets.Misc   Liabilities   Liabilities.Misc   Summary   

To view the total equalizing payment information on the current spreadsheet, select the icon   [image: ]   located to the right of the Court Determined Distributions header.

By default, the Court Determined equalizing payment for all assets and liabilities is calculated and displayed on the Summary page.  

[image: ]

The Petitioner and Respondent labels in the Equalizing Payment table are linked to the Summary page.

Select the   [image: ]   icon a second time to hide the equalizing payment snapshot.



[bookmark: _Toc32927757]Erase Row Values

	Tool
	[image: ]



	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

When the delete icon [image: ]  is selected, the default behavior is to erase the contents of the selected row(s) as long as it is not the last empty row. 

Select a cell in every row you wish to erase then select the [image: ]  icon on the category toolbar:

· Select  [image: ]  once to erase the selected rows.
· Select  [image: ]  a second time to delete the selected rows.

When the selected rows are empty, the [image: ]  icon will delete the rows on the first selection.

The  [image: ]  icon can also be configured to delete the content of the non-empty rows immediately (without erasing the row first).  Details about configuring the  [image: ]  icon can be found in the Delete Rows section of the Lagniappe. 

[bookmark: _Toc32927758]Errors, Crashes and Debug Windows (oh, my)

We hate this window even more than you do—really.  

[image: ]

The debug dialog means that the software has encountered something very unexpected.  Unfortunately, it also means that you will lose all your unsaved changes.  

These errors should be rare but when they happen, they are catastrophic to any unsaved data.  They seem to happen more frequently if it’s been a while since you’ve closed/quit Excel.  

So just like an iPhone, remember to save your spreadsheets and quit Excel often.

You can help us identify this problem in several ways:

· Select the Debug button on the dialog.  Selecting debug will bring up a window that highlights the offending line in the spreadsheet.  Don’t select end.  
· Contact us while the Debug dialog is still running.  Of course, this one is a long shot because it assumes everyone is available at the same time.  But if you can, we might be able to fix the problem (or figure a way around the problem) and we might not lose your data.
· Take a screenshot and email it to Judge Tennis.   Include any comments about what you think could have caused the problem.
· Send us your spreadsheet.  We can backtrack most problems this way if it’s easier for you.

We will make every effort to provide you a timely work around or a fix.

The remainder of this section is somewhat technical.  You don’t need to read it—just refer to it if you run into a problem.  If you do read it, I hope it reassures you that we have a few resources available for resolving problems.

The typical reasons a program will crash:	

Memory errors
These errors should be rare but when they happen, they are catastrophic to any unsaved data.  They seem to happen more frequently if it’s been a while since you’ve closed/quit Excel.  Like an iPhone, remember to save and quit often.

eQuit errors
These are the situations where you will encounter the Debug dialog.  These are typically the result of unanticipated user interactions—our bad.  The Debug dialog is actually a good thing   because it directs us to the problematic point in the code.  It can help us determine why we crashed and provide clues as to why things went wrong and how we might fix it (as long as you can leave the program open until you contact us).



Here is an example of the window you will see when you select the Debug push button from the Debug dialog.  The highlighted yellow line is pointing to the line that caused the crash.  With this window, we can determine exactly why this line of code crashed.

[image: ]


[bookmark: _Export_to_a]

[bookmark: _Toc32927759]Export to a .csv File


	Spreadsheets:    Settings

Exporting assets, liabilities and summary information from the spreadsheet to an external text file allows you to view your data in other applications.  

To export the contents of the Equitable Distribution Spreadsheets to a comma separated values file, select the Export to .csv file push button under the Input/Output Options heading on the Settings page.  Use the Save dialog to specify a location, name and format for the export file.  

              [image: ]

Two common file formats used when saving this type of data to a readable file are:

· Comma separated values (.csv) and 
· Text (.txt).  

A .csv file can be opened directly by Excel (the commas are used to separate the data into columns).  

For more details about using this .csv file as input into an eQuit Spreadsheet can be found in the Import a .csv File section of the Lagniappe.

[bookmark: _Format][bookmark: _Reformat_Spreadsheets][bookmark: _Format_Spreadsheets]

[bookmark: _Format_Spreadsheets_1][bookmark: _Toc32927760]Format Spreadsheets 

	Spreadsheets:    Settings

To correct any spreadsheet formatting problems, select the Format option buttons under the Layout Options heading on the Settings page.

Formatting problems can be either be appearance (fonts, borders, line wrapping) or functional (formulas). These can happen with repeated copying and pasting and moving things around. Reformatting options include:  

Row borders, infills and line numbers   
Is used to correct any cell rendering problems such as borders and infills.  It will also regenerate the line numbers.

Fonts  
Is used to correct any cell font rendering problems.  This can be used to fix hyperlink font problems and line wrapping issues.

Formulas  
Is used to correct any total/subtotal formulas that get out of sync.

First select one of the reformatting options, then apply the changes by selecting the Update formats … push button.

If reformatting does not correct the problem, it is possible that closing and reopening the spreadsheet will fix the remaining problems.  If that does not correct the problems, please contact Judge Tennis’ office.

For a discussion of the many gotchas associated with cut and paste, see the section,  "Annoying Things about Excel's Copy, Cut and Paste", at the end of this Lagniappe.

[bookmark: _Import_an_eQuit][bookmark: _Toc32927761]Import an eQuit Spreadsheet

	Spreadsheets:    Settings

To import an eQuit spreadsheet into the current spreadsheet, use the Import file (.xlsm or .csv) push button under the Input/Output Options heading on the Settings page.

The Import push button will launch an input file selector that is used to indicate the name, location and type of the input file.

eQuit spreadsheets are saved as macro-enabled Excel files (with a .xlsm file extension).  Only .xlsm files that have been created by eQuit may be imported into an eQuit spreadsheet.

· .xlsm files are macro-enabled Excel files.  
· .xls files are Excel files without macros.

Macros are the basis for all of the eQuit functionality.  So even if an eQuit spreadsheet has been saved as a .xls file, it cannot be imported.  

Imported eQuit Spreadsheets can either replace, append to or merge with the existing spreadsheet information.  Details about merging and managing merges after importing can be found in the Merge/Append Imported Spreadsheets section of the Lagniappe.

[bookmark: _Import_a_.csv][bookmark: _Toc32927762]Import a .csv File

	Spreadsheets:    Settings

To import an “eQuit formatted” .csv file into the current spreadsheet, use the Import file (.xlsm or .csv) push button under the Input/Output Options heading on the Settings page.  A .csv file that is not formatted properly will fail. 

The Import push button will launch an input file selector that is used to indicate the name, location and type of the input .csv file.

It is not necessary to save the eQuit spreadsheet as a .csv file in order to read the information into another eQuit spreadsheet (e.g. when you want to combine your spreadsheet with the spreadsheet from the opposing Party).  Just import the eQuit spreadsheet.  Details on how to import an eQuit spreadsheet into an existing eQuit spreadsheet are provided in the previous  section.

[bookmark: _Merge_/_Append]Imported .csv files, just as eQuit files,  can either replace, append to or merge with the existing spreadsheet information.  Details about merging and managing merges after importing can be found in the  next section.

[bookmark: _Toc32927763]Merge / Append Spreadsheets

	Spreadsheets:    Settings

Use the Import eQuit file option buttons under the Input/Output Options heading on the Settings page to specify how imported data should be read into the current spreadsheet.  

The options are:

New / Replace
Importing a spreadsheet as New will replace the existing data in the current spreadsheet.  This is the default.

Append
Append will add the new data to the existing data. 

Merge
Merge will combine records in the existing spreadsheets with data from the incoming spreadsheets when the Item values are an exact match.  Rows that do not match exactly will be appended to the existing data.  New data will not replace existing data.

Near matches occur when rows differ due to inconsistencies in spacing, misspelling, abbreviations, capitalization, terminology, etc.

After a merge, near matches must be reconciled.  The painful approach is to manually copy (or reenter) the information from the non-matching rows.  An alternative approach is to:

· Sort the spreadsheet by the item description.  Any inconsistencies between near matches may become more obvious when the records are adjacent to one another.  Details about sorting rows can be found in the Sort Rows section of the Lagniappe.
· Once sorted, you can force rows to merge using the combine tool.  Details about combining rows can be found in the Combine Rows section of the Lagniappe. 







[bookmark: _Toc32927764]Move Items Within a Category

	Tool
	[image: ][image: ]



	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

To move an item to a different position within the same category, 

· Select a cell in the row you wish to move, then 
· Select the move icon  [image: ]  or  [image: ]  on the  category toolbar.

[image: ]
[bookmark: _Paste_From_Another][bookmark: _Copy_and_Paste]
Rows will move up or down, one row at a time.

To move multiple rows in a category, 

· Select a cell in each row you wish to move, then
· Select a move icon on the  category toolbar.
· You can use rectangular selection or non-contiguous selection to select the rows.

Information on how to move items to a different category is proved in the next section.

[bookmark: _Move_Items_to]

[bookmark: _Toc32927765]Move Rows to a Different Category

	Tool
	[image: ]



	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

To move rows from one category to a different category (or spreadsheet), you will need to use the eQuit move tool.  

[image: ]

Use the move row icon  [image: ]  on the eQuit toolbar located at the top of the spreadsheet as follows:

· Select a cell in every row you wish to move.
· Use rectangular selection or non-contiguous selection to select multiple rows.
· Select the  [image: ]  icon located on the eQuit toolbar located at the top of the spreadsheet.
· After the New Location dialog appears, specify the destination by selecting a cell in the appropriate row.  



In this spreadsheet, it was determined that the Fidelity Retirement account was actually a Pre-Tax Retirement account.  The move tool was used to move the asset to the proper category.

[image: ]

[image: ]

[image: ]

If the destination rows are empty, the rows are moved into the selected row.  
[bookmark: _Unprotect_The_Spreadsheet][bookmark: _Number_Rows]Otherwise the rows are moved into new rows that are added after the selected row.
[bookmark: _Toc32927766]Number Rows

	Tool
	#



	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

To display or hide row numbers on the spreadsheets, select the row number icon  #  in the left-hand margin of any spreadsheet. Numbers will start at #1 for each separate category.

[image: ]

Numbers will start at #1 for each separate category.

[bookmark: _Print_Spreadsheets][bookmark: _Toc32927767]Print Spreadsheets

	Tool
	[image: ]



	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

To print the Equitable Distribution Spreadsheet, use the print icon  [image: ]  on the eQuit toolbar located at the top of the spreadsheet. 

[image: ]
Options for optimizing and stylizing the printed output are available under the Print Options heading on the Settings page.  The options include:

· Specify which pages are printed, by selecting one of the Spreadsheet option buttons. The default is all spreadsheets (pages).

· All spreadsheets
· All spreadsheets except for notes
· Summary page only
· Current page only

· Specify whether empty space is carried over to the printed page, by using the Remove check boxes.  By default, all the options are selected.

· Eliminate empty rows
· Eliminate empty categories 
· Do not print empty pages

· Specify the format for printing.

· Minimal Ink (limited color).  This is a stripped-down format for printing (no embellishments).  Color is used in a very limited way.  Red for negative numbers, blue for footnote links.  The default is to use minimal ink.  An example of the minimal ink output can be found in the Appendix section.  
· Minimal Ink (black and white).  As above but no color.  Best format for scanning.
· Full color.  A faithful representation of the colors used on the screen.

· Specify whether the page numbers and a time stamp are added to the bottom of each printed page.  The default is to include the footnote.
· Specify whether the case style information is included with the printed output.  The default is to use the case style page as the cover page for the printed output.
· Specify whether review guideline highlighting is applied to the printed output.  The default is to not apply the guidelines to the printed output.



Recommended Page settings for printing automatically defined for you.  The values are:

	Print option
	Setting

	Orientation
	Landscape

	Scale to fit
	On

	Pages wide
	1

	Pages tall
	1 for notes (100 for all others)

	Margin Top
	0

	Margin Bottom
	0.25

	Margin Left
	0.25

	Margin Right
	0.25

	Margin Header
	0

	Margin Footer
	0



To print very long (or very wide) spreadsheets may require some adjustments to one or more of these options.

You may certainly print spreadsheets in the Equitable Distribution Spreadsheet using the standard, Excel print operations.  

[bookmark: _Rename_Possessors]

[bookmark: _Toc32927768]Rename Possessor Values

	Spreadsheets:    Case Style

eQuit updates the possessors in the spreadsheets whenever the Petitioner/Respondent labels are changed.  However, there are situations where the labels used in the headers and drop-down lists become out of sync with the values in the Possessor column.

For example, it’s possible that the Petitioner and Respondent labels used in an existing spreadsheet will be different from those imported from a merged or appended spreadsheet.  

[image: ]

Should this occur, it is easy to reconcile these differences, and maintain a consistent terminology throughout the spreadsheet.

To rename the possessor values (e.g. change all values of Petitioner to Husband), use the Possession column options under the Layout Options heading on the Settings page.   Use the Replace/With drop-down lists with the Rename all push button to change the possessor values on all the pages of the spreadsheet.


[image: ]

[bookmark: _Resize_Item_(Description)]

[bookmark: _Toc32927769]Resize Item/Description Column

	Tool
	[image: ]



	Spreadsheets:    Assets   Assets.Misc   Liabilities   Liabilities.Misc

To expand and contract the width of the Item (Description) Column, each spreadsheet contains an expand icon    in the Item header.

The original size of the address column:

[image: ]

The address column after the column has been expanded:

[image: ]
[bookmark: _Equalizing_payment]
Regardless of the column width, labels that do not fit in the allocated space will be automatically wrapped onto a new line when you press the enter key.

Note:  Instead of resizing the item column, you can force a label to split into multiple lines at a specific character by typing the new line character, alt-Enter. 

[bookmark: _Review][bookmark: _Review_Spreadsheets]

[bookmark: _Toc32927770]Review the Spreadsheet

	Tool
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	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

To review your spreadsheet for specified  potential errors and omissions, select the review icon  [image: ]  on the eQuit toolbar located at the top of the spreadsheet.  

Any cells that do not adhere to the guidelines selected will be highlighted. No action will need to be taken to move forward, and the highlights may be cleared without changing any data. This tool may be used most often by the Court in preparing for Pre-trial Conferences. 

Check boxes for controlling which guidelines are applied when the  [image: ]  icon is selected can be found under the Review Options heading on the Settings page.  The guidelines are:

	
	

	1
	A possessor should be specified for an item with a non-zero value.

	2
	The Court determined distribution may match the distribution agreed to by the Parties.

	3
	An item’s valuation should match the distribution.

	4
	A valid item has no valuation or one that contains non-numeric amounts (e.g. UNK, TBD, etc.).  

	5
	
The last 4 digits of an account (e.g. a bank, credit card, 401k, etc.) should be included with this item.  When the account numbers are unknown, use #? to avoid flagging the item.  When account numbers are irrelevant, use ## to avoid flagging the item.

	6
	The Parties’ numeric valuations  are not the same.



By default, all the guidelines are selected, and are applied simultaneously.

Here is an example of Retirement Account entries after a spreadsheet review.

[image: ]


The highlighted cells in this example of Retirement Account assets indicate that there three areas that need further attention:

· Two account descriptions do not include the suggested, 4-digit, account number (guideline #5).   
· A valuation has been left as “Unk” (guideline #4).
· The Court has not filled in the determined distribution from the Parties’ distribution even though the values are in agreement (guideline #2).

Selections remain in effect until they are cleared.  Highlights are also saved when the spreadsheet is closed since they are table, infill colors.  

To clear selections, select the Clear selections push button under the Review Options heading on the Settings page.

When printing, select the Include review guidelines check box under the Print Options heading when you wish to add review highlighting to the printed spreadsheets. 

Options for controlling how the reviews are applied can be found under the Review Options heading on the Settings page.

· Select the Apply guidelines simultaneously option button to apply all the guidelines at one time.  This is the default.
· Select the Cycle through guidelines individually option button to apply the guidelines one at a time.  When this option is selected, press the review tool to display the results from the next guideline.

[bookmark: _Roles][bookmark: _Toc32927771]Role Mode

	Tool
	[image: ]



	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes   Case Style

The Role tool [image: ] is located on the eQuit toolbar at the top of the spreadsheet.  Roles are used to lock and gray fields that are not relevant under the current role.  For example, the Respondent’s and Judge’s fields are locked when the Petitioner is editing the spreadsheet.



The benefits of using role mode are:

· Grayed columns help you identify which information you are required to provide. 
· Locked columns reduce the number of cells you must tab through to edit your portion of the form.  
· Locked cells prevent unintended errors by protecting information that you should not be altering. 

The role tool in the eQuit toolbar is a link that takes you to the Role field located on the Case Style page.  Use the drop-down list on the Role field to specify your role.  

	Role
	Available Fields

	
	

	<empty>
	All

	Joint
	All

	Petitioner
	Petitioner valuation, distribution and notes 

	Respondent
	Respondent valuation, distribution and notes 

	Judge
	Court determined distributions fields only



In this spreadsheet, the user has assumed the role of Petitioner.  Respondent fields have been grayed out.  The Petitioner has further simplified the spreadsheet by hiding the Court determined valuation columns.  In addition, rows containing Respondent valuations or distributions cannot be deleted.

[image: ]

The Court determined distributions columns can be hidden using the Display Columns check boxes under the Layout Options heading on the Settings page if they are not relevant[footnoteRef:11].   [11:  Court determined distributions can be filled out by the Petitioner and Respondent only if there is an agreement about the distribution.  
] 

[bookmark: _Toc32927772]Save As (Important)

When saving an eQuit spreadsheet to be reopened with complete eQuit functionality, it must be saved as macro-enabled, Excel files (with a .xlsm file extension).  The macros embedded in the eQuit spreadsheets are the required for spreadsheets to function.  eQuit spreadsheets saved in any other format will not function as an eQuit spreadsheet.  

Very often, the default file type for the Save As … dialog is not .xlsm (usually .xls, and unfortunately not the file type you are currently using).  This means that you must be extremely careful when saving a backup using the Excel > File > Save As … dialog.  

[image: ]

As you can see from the drop-down list in the example show above, there are many file type choices.  In particular, these file type choices are often confused:

· .xlsm files are macro-enabled Excel files.  
· .xls files are Excel files without macros.

To properly save your eQuit spreadsheet, you must make sure the file type is Excel Macro-Enabled Workbook (.xlsm). 

To save the data associated with an eQuit spreadsheet, you can use the Export to .csv file … push button under the Input/Output Options heading on the Settings page.  Details about exporting to a .csv file can be found in the Export to a .csv File section of the Lagniappe.  Details about importing .csv files can be found in the Import a .csv File section of the Lagniappe.

When importing an eQuit spreadsheet into an existing eQuit spreadsheet, only .xlsm files that have been created by eQuit may be imported into an eQuit spreadsheet.  Details about importing eQuit spreadsheets can be found in the Import an eQuit Spreadsheet section of the Lagniappe.  

[bookmark: _Toc32927773]Scroll Column Headers

	Spreadsheets:    Settings

To toggle the freeze pane feature that is associated with the spreadsheet header,
use the Display freeze pane option button under the Layout Options heading on the Settings page. You should try this option out to see which mode is more comfortable for you to work in. 

By default, the asset and liability spreadsheets are designed so that the column headers remain in a fixed/locked position (visible) when the spreadsheet is scrolled vertically.  Excel refers to this behavior as a freezing.  

The frozen row for asset and liability spreadsheets is row eight.

[bookmark: _Sort_Rows][bookmark: _Toc32927774]Sort Rows

	Tools
	[image: ]
	[image: ]
	[image: ]



	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

To sort the rows in a spreadsheet by Item or Possession, select the one of the sorting icons located inside the top, category header on the spreadsheet.  By default, categories are sorted independently.



The spreadsheet below shows Real Property assets in the order they were entered:

[image: ] 

The updated spreadsheet shows Real Property assets after the category is sorted by possessor:

[image: ]

The three, sorting icons are as follows:

	Square
	Original order (unsorted)

	Up triangle
	Sorted ascending

	Down triangle
	Sorted descending




When the sort icon is selected, the tool will cycle through the three, sorting options.

The sort icons can be configured to use nested sorting (i.e. sorting Item values within sorted values of Possession).  Do this by selecting the Dependent (item by possession) option button under the Tool Options heading on the Settings page.

Note that If the original, unsorted order is important to you, 

· Sort after all your data are entered.
· Dependent sorting may prevent you from returning to the original order.

If you do an appended or merged import, sorting may be helpful in locating duplicate records or records that are near (i.e. not exact) matches.  Details about merging and combining rows can be found in the Merging Equitable Distribution Spreadsheets and Combining Rows sections of the Lagniappe. 

[bookmark: _Unlock_the_spreadsheets][bookmark: _Unlock_Spreadsheets][bookmark: _Toc32927775]Unlock Spreadsheets  

	Tool
	[image: ]



	Spreadsheets:    Assets   Assets.Misc   Assets.Notes   Liabilities   Liabilities.Misc   Liabilities.Notes

IMPORTANT:  Proceed cautiously with this tool. The need for unlocking spreadsheets has been largely superseded by the functionality provided by the new move tool in the eQuit toolbar.  Details about the new move tool can be found in the Move Rows to a Different Category section of the Lagniappe.

To paste one or more rows of data, you will need to unlock the spreadsheet and understand how protected areas are used inside the spreadsheet.

The unlock icon [image: ] is located in the eQuit toolbar at the top of the spreadsheet.

By design, the spreadsheets are protected, and the non-data fields are locked.  This has two advantages.  It prevents errors and makes it easier to navigate around the data fields.  The disadvantage is that the paste operation is restricted.  



To paste more than one value at a time (for example, an entire row of data), you will first need to unlock the spreadsheet selecting the [image: ]  icon[footnoteRef:12].     [12:  It is only necessary to unlock the spreadsheet if your paste block intersects a locked area.  In the example show, the column between the Marital Asset description and the Court Determined Distributions is a locked area.
] 


[image: ]

After the icon is selected, the column headers will be highlighted, indicating that the data rows are unlocked and unprotected (i.e. open).

[image: ]

Unlocked rows are susceptible to user error.  It’s possible to add text to unlocked cells.  It is also possible to corrupt the integrity of the spreadsheet formulas rendering--the current project useless.  

The highlighted headers have two purposes.  They:

· represent the paste-able area of the table.
· serve as a reminder to lock the spreadsheet as soon as you are finished pasting.
In unprotected mode, you can select the contents of one spreadsheet and paste it into existing rows of another spreadsheet using the following guidelines.

1. Only the receiving spreadsheet needs to be unlocked for pasting to work.  
2. Only paste into existing rows.  Use the  +  icon to add rows as needed.
3. Only select contiguous cells inside the paste-able area of the table (as indicated by the highlighted columns:

[image: ]

4. If you attempt to paste data outside the paste-able area, a popup alert will explain that you are attempting to paste into a locked cell or a protected spreadsheet.
[image: ]


5. Immediately after pasting, be sure to select Match Destination Formatting from the    clipboard popup at the bottom of the paste block.  This will ensure that the spreadsheet style properties (background, borders, formatting etc.) are preserved.  

[image: ]

Should you make a mistake, you can often correct it with the undo action ( on the Excel Quick Access Toolbar, ⌘ + z on the Mac, or ctrl + z on a PC).

6. Because this is a protected spreadsheet, you cannot copy and insert rows using the Excel, row, popup menu.   Do not select and insert entire rows (Insert Copied Cells…).

[image: ]








7. Only select cells in one category at a time.  

[image: ]

Do not select cells across multiple categories.

[image: ]

8. Remember to return the spreadsheet back to the locked state when you are finished pasting to avoid corrupting the spreadsheet formulas.
[bookmark: _Add_notes][bookmark: _Add_footnotes]
[bookmark: _Add_Notes_Using]









[bookmark: _Zoom_the_Spreadsheets][bookmark: _Toc32927776]Zoom Spreadsheets

	Spreadsheets:    Settings

To specify a zoom factor for all the spreadsheets at once, select the Zoom all spreadsheets push button under the Layout Options heading on the Settings page. This may be easier than adjusting the sizing of each page with the slide measure at the bottom right hand corner. 

This will open a dialog window that allows you specify a zoom factor to be used for all sheets.

[image: ]

Spreadsheets can be individually sized at any time using the zoom controls in the bottom right corner of the Excel window. 
[bookmark: _Lagniappe][bookmark: _Macros]
[bookmark: _Annoying_Things_About][bookmark: _Toc32927777]Annoying Things About Excel’s Copy, Cut and Paste

Copy, cut and paste in Excel is legendary with respect to the amount of frustration it generates.  It’s truly exasperating to just about everyone who write or uses a template (just Google it).  

When you copy a selection of cells, Excel puts a copy of the cell values onto the clipboard for you to use.  As you would expect.  But, unknowingly to a lot of users, it also slurps up all of the “source’s” formatting attributes;  colors, fills, formats, formats, etc.  

Cut takes this one step further.  When you cut a selection of cells, it removes the contents and all the formatting attributes from the “source”—leaving a large gaping hole in the center of any beautifully formatted template (like eQuit).  

Then, when you paste the contents into a “formatted receiving” cells of an eQuit spreadsheet, it inserts the data into eQuit.  As you would expect.  But it also takes the  slurped-up attributes and regurgitates them into eQuit--overwriting all of those  beautifully formatted attributes.  

Copy, cut and paste from an outside “source”, like Word document or a different Excel template, and it’s like you’re reaching into Gump’s box of chocolates.

eQuit goes to extreme lengths to format the spreadsheets so they look like you would expect—professional, dollar formats on numbers, gray backgrounds, white fields, FORMULAS!  And so, you can wind up with some wonky looking output after you’ve had a few cuts and pastes.

The Microsoft solution is to provide you with a teeny, tiny, clipboard option icon in the lower right-hand corner of the “receiving” area, usually under the normal “paste” options in a teenier line called “Paste Special”.  See the previous figure.  As a template user, you are supposed to know (because Microsoft provides us with wonderful documentation) that you need to use that icon thingy to “Paste Special” and  use the “destination’s formatting”.

Whew!  Got all that?  

So, what’s an  eQuitter to do?

Nice, but we don’t quit.  eQuit provides some reformatting tools under the Layout Options heading on the Settings page.  Use them to correct any problems in the spreadsheets if your cuts and pastes have run amuck.  Errors can include incorrect:

· Cell fill colors and borders
· Text formats and line wrapping
· Line numbering
· Equations

Details about the reformatting options can be found in the Format Spreadsheets section of the Lagniappe. 


[bookmark: _Toc32927778]Macros  

To access a macro, launch the Macro dialog by selecting View > View Macros on the Excel Tool Ribbon (or use the keyboard shortcut alt-F8).  Select the desired macro from the list of macros and launch it by selecting Run.  

	Public 
	Description
	Shortcut

	ExportCSV
	Export values to csv file
	ctrl-shift + X

	FootnoteAdd
	Create footnote hyperlink
	

	ResetFont
	Apply default font to the current cell
	ctrl-shift + R

	SubtotalToggle
	Toggle Equalize subtotal rows
	.

	ZoomAll
	Set zoom for all spreadsheets
	ctrl-shift + Z

	
	
	



You may assign a keyboard shortcut to any macro by selecting Options… from the Macro dialog.

Navigation macros

	Public 
	Description
	Shortcut

	PrintCompressed
	Print compressed spreadsheet B&W
	ctrl-shift + P

	GoToFirst
	Move the cursor to the first row
	ctrl-shift + HOME

	
	
	ctrl-shift + LEFT

	GoToLast
	Move the cursor to the last row
	ctrl-shift + END

	
	
	ctrl-shift + RIGHT

	SheetNext
	Navigate to next spreadsheet
	ctrl-shift + 

	SheetPrev
	Navigate to previous spreadsheet
	ctrl-shift + 

	
	
	

	
	
	



Tool macros

	Public 
	Description
	Shortcut

	RowAdd
	Add row
	ctrl-shift + PLUS	

	RowDelete
	Delete row
	ctrl-shift + MINUS

	RowUp
	Move row up
	ctrl-shift + UP

	RowDown
	Move row down
	ctrl-shift + DOWN

	RowLink
	Create hyperlink
	ctrl-shift + L

	RowMove
	Move selected rows
	ctrl-shift + M

	RowNumbers
	Toggle row numbers
	ctrl-shift + #


[bookmark: _Ribbons_/_Toolbars]

[bookmark: _Toc32927779]Keyboard Shortcuts

Here is a list of a few standard Excel keyboard shortcuts that you may find useful while editing your spreadsheet.

	Action
	Mac
	PC
	Quick Access 
Toolbar[footnoteRef:13] [13:  The Quick Access Toolbar is a customizable toolbar at the top of the Excel window.] 


	Copy selection
	⌘ + c
	ctrl + c
	

	Cut selection
	⌘ + x
	ctrl + x
	

	Paste selection
	⌘ + v
	ctrl + v
	

	Undo
	⌘ + z
	ctrl + z
	

	Redo
	⌘ + y
	ctrl + y
	

	Print (color)
	⌘ + p
	ctrl + p
	

	Clear clipboard
	esc
	esc
	

	Macro dialog
	alt-F8
	alt-F8
	

	New line
	alt-Enter
	alt-Enter
	
























[bookmark: _Transfer_information_from][bookmark: _Download_the_spreadsheet][bookmark: _Frequently_Asked_Questions][bookmark: _Frequently_Asked_Questions_1][bookmark: _Ref8658475][bookmark: _Ref8658511]

[bookmark: _Toc32927780]Frequently Asked Questions 


[bookmark: _Toc32927781]Technical Issues

[bookmark: _Toc32927782]Does the spreadsheet have a simple calculator?

The Equitable Distribution Spreadsheet performs computations on all the valuations for you.  Computations preceding the valuations must be done outside the spreadsheet.

[bookmark: _Toc32927783]Why is my spreadsheet not scrolling?

Be sure you have your pointing cursor below the frozen pane line when you start to scroll.  You can “unfreeze” the panes on the Settings page if you want to have full scrolling on all pages.  If you just want to minimize the real estate taken up by the headers, consider using the first, row group control to hide the case information in the headers.

[bookmark: _Toc32927784]Can I change the zoom level for all the spreadsheets at one time?     

Yes.  Details about zooming can be found in the Zoom Spreadsheets section of the Lagniappe. 

[bookmark: _Toc32927785]Can I force text onto a new line in the asset/liability description?

Yes.  Text can be split into multiple lines by using alt-Enter at the point where you would like to force a new line.

[bookmark: _Toc32927786]Sometimes my text doesn’t wrap properly to a new line.

This seems to be an intermittent problem with Excel.  Details about reformatting spreadsheets can be found in the Format Spreadsheets section of the Lagniappe.   Saving and reopening the spreadsheet will often fix the problem as well.

[bookmark: _Toc32927787]Can I print all the spreadsheets at one time?

Yes.  When you use the [image: ]  icon at the top of the spreadsheet, you can specify which spreadsheets are printed using options on the Settings page.  Details about printing can be found in the Print Spreadsheets section of the Lagniappe.  When you use the standard, Excel printing operation, the Printer dialog provides an option for you to select which sheets are printed.  
[bookmark: _Toc32927788]Why does the cell background change when I cut data from the spreadsheet?

Please avoid cutting text.  The cut operation moves the text, the format and the background fill to the clipboard.  The delete key only removes the text.  The preferred approach is always to copy the data, paste it into the new area, and then delete the old data using the delete key.

[bookmark: _How_can_I][bookmark: _Toc32927789]Can I “fix” the cell formatting (font, background color, etc.)?

Yes.  Font and cell background color or borders are often the result of copy/paste or delete operations.  These can be fixed by reformatting the spreadsheet from the Settings page.  Details about reformatting spreadsheets can be found in the Format Spreadsheets section of the Lagniappe.  

[bookmark: _Toc32927790]Why is my text underlined?

You probably did not use the  [image: ]  icon to delete a footnote in that row.   When a hyperlink is defined, Excel automatically underlines the text and changes the font color.  When the hyperlink is deleted, the underline and color remain.  Avoid this by always using the [image: ]  icon to delete a link.

To correct the formatting, delete the text from the cell and press the [image: ]  icon.
Details about reformatting spreadsheets can be found in the Format Spreadsheets section of the Lagniappe.
 
[bookmark: _Toc32927791]Am I limited to the space shown for item descriptions and notes?

No.  The description fields are fixed in width, but the text will wrap into multiple lines as needed.

[bookmark: _Toc32927792]Can I define Enter/Return to move to the right instead of down?

Yes.  The cursor movement behavior can be changed using the Excel > Preferences > Edit tab.  If you do not want to permanently change the behavior, you can use the Tab key to move right.  Alternatively, select the row (after which the Enter key will move the cursor to the right).

[bookmark: _Toc32927793]Can I move a row from one category to another?

Yes.  The  [image: ] move tool at the top of each spreadsheet moves rows to different categories.
Details about moving rows can be found in the Move Items section of the Lagniappe.

[bookmark: _What_should_I][bookmark: _Toc32927794]What should I do when I get the dreaded Debug dialog?

Details about dealing with a program crash and the debug dialog can be found in the Debug section of the Lagniappe.


[bookmark: _Toc32927795]My cursor is telling me to wait.  It shouldn’t take this long to perform the operation I requested.  Is the program hung?

Possibly, but it’s more likely the cursor shape was not reset after an eQuit operation.  Try doing a simple operation like adding or deleting a line to reset the cursor.  If you can do that, the program is not hung.  

[bookmark: _Toc32927796]Practical Issues

[bookmark: _Toc32927797]How should my clients work with the spreadsheet?

You can provide your client with the Equitable Distribution Spreadsheet and have them email it back to you and transfer that information into your own version,

or you can print out the spreadsheets that you want them to fill out manually,

or you can provide them the blank forms from the Getting Started page in the Equitable Distribution Spreadsheet.


[bookmark: _Toc18051353][bookmark: _Toc32927798]Is there a limit to the information I can include in the Notes sections?

Technically, the program will not limit you. But the point of the Spreadsheet is not to become a Word document. Longer explanations should be included instead in the Joint Pre-Trial Memorandum/Stipulations. Amounts included in the Notes will not be included in the Summary page.

[bookmark: _Toc18051354][bookmark: _Toc32927799]What about “partially” marital assets and liabilities?

Only the Marital Values as determined by the Parties should be included in the Assets and Liabilities pages. The Non-Marital portion, as well as any description or further information, can be included in the Notes section and / or the Joint Pre-trial Memorandum. Lengthy information, including the Parties calculation using the formula in Florida Statute 61.075 should be included in the Joint Pre-trial Memorandum. 

[bookmark: _Toc18051355][bookmark: _Toc32927800]What about assets that are being divided as of a particular date and we don’t know the exact value?

Assets (or liabilities) that are going to be divided as of particular date, or otherwise intended to be outside of the net calculation on the Summary page, may be added to the Notes sections.   If an approximation can be made as to the marital and non-marital portions of that asset or liability, it should also be included. A retirement account being divided separately by QDRO, for example may be included here. NOTE: this would mean that asset is not included in the ED calculations nor the Summary section.

[bookmark: _Toc18051356][bookmark: _Toc32927801]What if there is not a good place to put an item that one of the Parties thinks is important?

Remember that this Spreadsheet is meant to be an easy visual representation of information, not a complete compendium of every fact necessary to be determined at trial. It may be that there is information that does not technically get included in the overall calculations that can be included in the Notes sections, or it may be better included in the Joint Pre-Trial Memorandum. 

[bookmark: _Toc32927802]Cooperation Problems
[bookmark: _Toc18051357]
[bookmark: _Toc32927803]What if there is not cooperation in completing the joint Equitable Distribution Spreadsheet?

If you are the Petitioner and have completed the Spreadsheet and provided to opposing counsel or party and they fail to complete same, file your version with a Pre-Trial Memorandum (or the Joint Pretrial Memorandum) and request sanctions; which may include fees, or striking of pleadings or issues, or the Court determining that that Party’s valuations will be used. If you are the Respondent and the Petitioner fails to provide same after reasonable request and reference to the Pre-trial Order, file your version with a Pre-Trial Memorandum (or the Joint Pretrial Memorandum) and request sanctions. This will of course vary, depending on whether opposing party is represented, the state of the pleadings, and demonstrated undue prejudice resulting from sanctions considered. Parties who file a Notice for Trial are deemed prepared for trial, and that would include being prepared to timely provide this joint Equitable Distribution Spreadsheet.

The Court expects that any Party who cannot provide a completed Equitable Distribution Spreadsheet and cooperate timely with the preparation of a Joint Pre-trial Memorandum/Stipulations will not file a Notice for Trial and will file a timely Motion to Continue the Pretrial. Any Motion to Continue should indicate how many days are needed to complete all requirements. 

At the Pre-trial Conference, any Party who has not completed their part of the Pre-trial requirements, and who is therefore holding up the setting of the trial, will face sanctions. Those sanctions may run to the party and / or to the lawyer, depending on who is at fault. 

[bookmark: _Toc32927804]What if the other party changes my data?

ALWAYS keep a copy of the Equitable Distribution Spreadsheet as you completed it. It is also advised that you file a copy of the Spreadsheet with the Court. Any discrepancies should be brought to the Court’s attention.

[bookmark: _Toc32927805]What if I don’t have the information because my client does not have it?

This is a trick question. If there has been a Notice for Trial filed, and if there has been no Motion to Continue filed, then all information needed should be available and contained within the Equitable Distribution Spreadsheet and Joint Pre-trial Memorandum/Stipulations. IF there is a situation where the final few numbers are trickling in, this may be indicated with TBA, but that should be linked to Notes page with an ETA. 

[bookmark: _Appendices]

[bookmark: _Toc32927806]Appendices


[bookmark: _Toc32927807]Download the Spreadsheet

The Equitable Distribution Spreadsheet is macro-enabled Excel spreadsheet.  Macros enhance the user experience and are essential for computing various calculations.  For the spreadsheets to function properly, you must enable macros.

Warning:  Although useful, macros if misused, can be dangerous to your data.  If you unknowingly run a malicious macro, it could corrupt your Microsoft Office installation or even your computer.  For this reason, Microsoft has disabled external (or un-trusted) macros by default.

When you open a file that has macros, a warning dialog (or a yellow message bar with a shield icon and the Enable Content button) will appear.  

      [image: Security Warning Message Bar for macros]

If you wrote the macro, or the macros are from a reliable source, select Enable Content.

· Download the Equitable Distribution Spreadsheet.xlsm from the Division 30 page of the 9th Circuit website to a location on your computer.

https://ninthcircuit.org/about/judges/circuit/diana-m-tennis 

· Open the Equitable Distribution Spreadsheet.xlsm by double-clicking on the file.

· Enable the macro content (each time you open a spreadsheet).

The macros in this spreadsheet perform numerous setup actions so it may take some time for the macros to run and the spreadsheet to become active.  Please be patient while the startup macros run.

[bookmark: _Save_as_a][bookmark: _Ref8658606]

[bookmark: _Toc32927808]Save As a Personal Excel Template 

When you edit the downloaded spreadsheet directly, your data is saved with the spreadsheet.  The next time you open that spreadsheet, you will be editing the saved data.  When you want to start a new spreadsheet (for a new case), you can easily overwrite (i.e. lose) this data, unless you save the spreadsheet correctly.  Templates solve this problem.

Creating a template on your system from the downloaded spreadsheet ensures that the template is saved and will be accessible by your version of Excel.  Think of the template as an empty form.  When you open a template, you will always be editing a new spreadsheet.  When you close a template, you will be asked to save it as a new spreadsheet (or to replace an existing spreadsheet).

Templates are saved in different places on different computers (e.g. Mac vs PC) and on different versions of Excel (e.g. Excel 365 vs Excel 2007).  These instructions are for Microsoft 365 on a Mac (though the process is the similar for other systems).  If the instructions below do not match the menus or dialogs you see on your computer, you can use the following link for instructions that are specific to your environment.

https://support.office.com/en-gb/article/save-a-workbook-as-a-template-58c6625a-2c0b-4446-9689-ad8baec39e1e 

Important points to remember:

· A template is just a form--it has no data.
· The eQuit template must be Macro-Enabled (i.e. with a .xltm extension)!
A spreadsheet is a completed template--a file with all the data.
· Use File > New to open a new spreadsheet from a template (when you are starting a new case).  
· Use File > Open to open an existing (saved) spreadsheet when you want to edit data from an existing case.


[bookmark: _Toc32927809]•  Instructions for Windows PC

Begin by opening the downloaded, Equitable Distribution Spreadsheet as outlined in the previous section.

To save the spreadsheet as a personal Excel template, select File > Save as > Browse…  
Make the following changes on the Save dialog:

· Be sure to keep the default file location.
· Change the File Format to Excel Macro-Enabled Template (.xltm).
· N.B.  The eQuit template must be Macro-Enabled!
· Change the File Name to something identifiable (for example Equitable Distribution Template v32.17.xltm)
· Select Save, and then close Excel.
	

                      [image: ]



[bookmark: _Toc32927810]•  Instructions for Mac

To save the spreadsheet as a personal Excel template, select File > Save as Template…  
Make the following changes on the Save dialog:

· Be sure to keep the default file location.
· Change the File Format to Excel Macro-Enabled Template (.xltm).
· N.B.  The eQuit template must be Macro-Enabled!
· Change the File Name to something identifiable (for example Equitable Distribution Template v32.17.xltm)
· Select Save, and then close Excel.


                    [image: ]






[bookmark: _Create_a_New]

[bookmark: _Toc32927811]Create a New Spreadsheet

Once you have saved the spreadsheet as a template, you open new spreadsheets using the Personal Templates tab in Excel.  You no longer need to access the spreadsheet that you downloaded from the 9th Circuit website.

[bookmark: _Toc32927812]•  Instructions for Windows PC

To create a new spreadsheet from your Equitable Distribution Spreadsheet template:

· Open Excel
· Select File > New (do not use File > Open!)
· Switch to the Personal tab
· Double-click on the Equitable Distribution Template v32.17 shortcut.

  [image: ]

Excel will start a new spreadsheet.  After you have entered in all your data, all that remains is for you to save it as an Excel file using a file name you associate with your case.

Important:  ALWAYS save your data as an Excel Macro-Enabled File (.xlsm) so the spreadsheet retains all the built-in functionality when you reopen it for editing.
[bookmark: _Toc32927813]•  Instructions for Mac

To create a new spreadsheet from your Equitable Distribution Spreadsheet template:

· Open Excel
· Select File > New
· Switch to the Personal tab
· Double-click on the Equitable Distribution Template v21.0 shortcut.

[image: ]

Excel will start a new spreadsheet.  After you have entered in all your data, all that remains is for you to save it as an Excel file using a file name you associate with your case.

Important:  ALWAYS save your data as an Excel Macro-Enabled File (.xlsm) so the spreadsheet retains all the built-in functionality when you reopen it for editing.
[bookmark: _Example:__Assets]
[bookmark: _Example:__Assets_1]

[bookmark: _Toc32927814]Figure:  Assets Spreadsheet


[bookmark: _Example:__Liabilities][image: ]

[bookmark: _Toc32927815]Figure:  Liabilities Spreadsheet


[image: ]
[bookmark: _Example:__Notes_1]

[bookmark: _Toc32927816]Figure:  Notes Spreadsheet


[image: ]
[bookmark: _Example:__Notes][bookmark: _Example:__Miscellaneous]

[bookmark: _Toc32927817]Figure:  Miscellaneous Spreadsheet


[image: ]
[bookmark: _Example:__Summary]

[bookmark: _Toc32927818]Figure:  Summary Page


[image: ]


[bookmark: _Toc32927819]Figure:  Settings Page

[image: ]
[bookmark: _Example:__Print]

[bookmark: _Toc32927820]Figure:  Printed Table (Minimal Ink)


[image: ]
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Case Style
Case Number   



Date of Marriage     
Date of Filing     



    



Real Property Titled Address Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Accounts Titled Institution  +  last 4 Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Retirement Titled Institution  +  last 4 Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Pre-Tax Retirement Titled Institution  +  last 4 Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Business Interests Possession Entity Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Personal Property Possession Item Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Vehicles Titled Vehicle Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Contingent Assets Titled Item Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Total Assets 0 0 0 0 0 0 0 0 



• eQuit v36  © 2019  Diana M. Tennis



Petitioner Respondent Petitioner Respondent



 



Marital Assets Court Determined Valuations Proposed Distributions
Distributions
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Case Style
Case Number   



Date of Marriage     
Date of Filing     



    



Mortgage Signor Institution  +  last 4 Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Credit Cards Signor Institution  +  last 4 Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Vehicle Loans Signor Institution  +  last 4 Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



IRS Debt Signor Item Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Contingent Liabilities Signor Item Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Total Liabilities 0 0 0 0 0 0 0 0 
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Case Number   
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Date of Filing     



    



Miscellaneous Possession Item Petitioner Respondent Date Valuations Date Valuations Petitioner Respondent Petitioner Respondent



Subtotal 0 0 0 0 0 0 0 0 



Total Miscellaneous 0 0 0 0 0 0 0 0 
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Case Style °
Case Number



Date of Marriage
Date of Filing



Petitioner Respondent Petitioner Respondent Petitioner Respondent



Total Assets 0 0 0 0 0 0 



Total Liabilities 0 0 0 0 0 0 



Net 0 0 0 0 0 0 



Equalizing Payment 0 0 0 0 0 0 



Net Equalized 0 0 0 0 0 0 
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Case Style
Case Number OC-12345   



Date of Marriage 12/31/2020     
Date of Filing 12/31/2020     



    



Row Possession Item Husband Wife Date Valuations Date Valuations Husband Wife Husband Wife



Real Property Husband
1313-A Mockingbird Ln 
Winter Park, FL  32789



0 1,000 12/31/2020 1,525 12/31/2020 1,698 2,125 2,385 2,797 3,483 



2 Joint
1313-B Mockingbird Ln 
Winter Park, FL  32789



2,045 2,045 12/31/2020 4,923 12/31/2020 5,565 6,085 6,496 7,347 7,478 



Accounts Joint Institution 1 #5714 500 500 12/31/2020 1,024 12/31/2020 1,782 2,516 2,719 3,517 3,965 
2 Wife Institution 2 #3676 4,842 0 12/31/2020 5,823 12/31/2020 6,206 7,013 7,850 8,125 8,188 



Retirement Wife Institution 1 #5622 1,000 0 12/31/2020 1,752 12/31/2020 2,058 2,511 2,787 3,737 4,429 
2 Husband Institution 2 #4695 0 5,038 12/31/2020 5,620 12/31/2020 5,970 6,882 7,449 8,213 8,337 



Pre-Tax Retirement Joint Institution 1 #6600 500 500 12/31/2020 1,939 12/31/2020 2,701 3,551 3,900 4,151 4,441 
2 Husband Institution 2 #9705 0 4,564 12/31/2020 5,510 12/31/2020 6,137 6,669 7,328 8,022 8,552 



Business Interests Joint Business Interests 1 500 500 12/31/2020 1,010 12/31/2020 1,785 1,975 1,977 2,810 3,038 
2 Wife Business Interests 2 3,353 0 12/31/2020 3,545 12/31/2020 4,145 4,441 5,321 6,125 7,067 



Personal Property Joint Personal Property 1 500 500 12/31/2020 1,968 12/31/2020 2,807 3,309 3,933 4,044 4,571 
2 Joint Personal Property 2 2,452 2,452 12/31/2020 5,056 12/31/2020 5,987 6,710 6,867 7,726 8,161 



Vehicles Husband Vehicles 1 0 1,000 12/31/2020 1,407 12/31/2020 1,890 2,144 2,771 3,153 3,842 
2 Wife Vehicles 2 4,334 0 12/31/2020 4,726 12/31/2020 5,500 6,324 6,352 6,892 6,964 



Contingent Assets Wife Contingent Assets 1 1,000 0 12/31/2020 1,964 12/31/2020 2,261 2,424 2,834 3,652 3,738 
2 Wife Contingent Assets 2 4,731 0 12/31/2020 4,901 12/31/2020 5,639 6,238 6,250 6,968 7,925 



Total Assets 25,757 18,099 52,693 62,131 70,917 77,219 87,279 94,179 
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